Experiment HP-7: Hypothesis-driven Biofeedback Lab/Research Study
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What is Biofeedback?
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Biofeedback is a technique that people can use to learn to control their body's physiological functions.
The definition of biofeedback states: a process that enables an individual to learn how to change
physiological activity for the purposes of improving health, performance, and eliminating anxiety or
stress. Physiology recording instruments are used to measure the body’s activity such as brainwaves,
heart function, breathing depth and rate, muscle activity, skin temperature and more. These instruments
“feed back” information to the subject via images or values. This information, often in conjunction
with changes in thinking, emotions, and behavior helps support the desired physiological changes.

How does it work?
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A better and easier definition of biofeedback is that it is the process of gaining greater awareness of the
body’s physiological functions primarily using instruments that provide information about those
systems, with the goal of being able to alter them at will.

With biofeedback, the subject will be connected to sensors that help receive information about the
subject’s body. This feedback helps the individual focus on making subtle changes, such as relaxing
certain muscles, to achieve the wanted results, such as reducing pain. Biofeedback gives people the
power of their thoughts to control their body’s activities and is often used as a relaxation technique. It
appeals to many people for a variety of reasons; it is non-invasive, painless and can even eliminate the
use of certain medications.

xS

During a biofeedback session electrical sensors monitor the body's physiological state, such as brain
waves, skin temperature or muscle tension. This information is fed back to the subject via cues, such as
a beeping sound, a flashing light, or even just watching the data recorded change in real time. The
feedback teaches individuals to change or control their body's physiological reactions by changing
thoughts, emotions or behavior. A typical biofeedback session can last from 30 to 60 minutes.
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Biofeedback techniques can include:
• Electromyography (EMG) biofeedback which gives information about muscle tension to learn
relaxation.
• Temperature (thermal) biofeedback allows an individual to see a drop in body temperature due
to stress and start relaxation techniques.
• Galvanic skin response training which measure the activity of sweat glands and the amount of
perspiration on the skin, alerting you to anxiety.
• Heart rate biofeedback which enables control of heart rate in an effort to improve blood
pressure, lung function, and reduce stress and anxiety.
This lab is meant to be a “hypothesis-driven” lab where students will come up with a technique or
techniques they would like their subject to try in order to alter some aspect of the subject’s
physiological parameters. This can include: reducing heart rate, sweating, altering body temperature
and/or breathing rate. The settings file for this lab is currently set up to record: ECG, Skin
Conductance, and Heart Rate. Parameters can be added or removed based on what the goal of the
hypothesis is.
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Biofeedback Suggestions:
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Note: All suggestions and techniques should be fully researched first to gain an understanding of
the effect(s) it may have on your subject.
Hypotheses and techniques MUST be approved by the instructor prior to any experimentation.
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It is also important to make sure the technique is applied and used properly.
Deep breathing

•

Yogic breathing

•

Repetitive statements (“I am not cold”, “I am not scared”, “I am warm on a sunny beach”, etc...)

•

Imagery (Note: images can up uploaded to the settings file using “Sequences”)

•

Progressive muscle relaxation

•

Guided imagery and meditation

Experimental Suggestions:
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•

Subject is anxious after watching scary video clips. Use techniques that would allow the
subject to reduce their anxiety levels.

•

Subject is warmed using a blanket; use techniques for cooling body temperature.

•

Subject is cold; use techniques for warming body temperature.

•

Subject is tense after being given a hard test (try the “Stroop Effect” or hard oral math
questions). Use techniques that would relax muscle tension.
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Experiment HP-7: Hypothesis-driven Biofeedback Lab/Research Study
Equipment Required
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PC or Mac Computer
IX-EEG USB data recorder
GSR electrodes
Three ECG electrodes
Oral or skin temperature thermometer
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Manual or automatic blood pressure monitor
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USB cable

**Note: adding or removing sensors for this experiment is left open-ended. As many parameters as
the hypothesis is looking at can be measured. As an example, the IX-EEG EMG electrodes can be
added to record muscle activity as well.
Extra items such as: blankets, a variety of feeling producing images, ice packs, paper bags, etc...
may be needed depending on the hypothesis.
IX-EEG Setup

Use the USB cable to connect the computer to the USB port on the IX-EEG.
Start the Software
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1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is
not available, click on the Windows Start menu, move the cursor to All Programs and then to
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window
will appear as the program opens.
2. On the Main window, pull down the Settings menu and select Load Group.
3. Locate the folder that contains the settings group, IX-EEG.iwxgrp. Select this group and click
Open.
4. Pull down the Settings menu again. Select the Biofeedback settings file from Human
Psychophysiology.
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5. After a short time, LabScribe will appear on the computer screen as configured by the
Biofeedback settings.
6. For your information, the settings used to configure the LabScribe software and the IX-EEG
unit for this experiment are programmed on the Preferences Dialog window which can be
viewed by selecting Preferences from the Edit menu on the LabScribe Main window.
7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any
of the following documents:
•
•

Appendix
Background
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•
•

Labs
Setup (opens automatically)
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Sensor Setup
1. Locate the yellow and blue GSR electrodes and the red, black, and green ECG electrodes
(Figure HP-7-S1).

Attach the yellow and blue GSR electrodes to the color coded connectors on the rear of
the IX-EEG.
•
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Note – the GSR unit is precalibrated. No other calibration is needed.

Attach the GSR electrodes to the pointer and ring finger of the subject's hand. Make
sure the fingers are not too cold or too dry.

•

Attach the black, red, and green electrodes to the color coded connectors on the IX-EEG.

am
ple

•

2. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the
subject’s right wrist/clavicle. Let the area dry.
3. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the
scrubbed area on the wrist/clavicle.
4. Repeat Steps 3 and 4 for the inside of the left wrist/clavicle and the inside of the right ankle.
Snap the lead wires onto the electrodes, so that:
the red (+1) lead is attached to the left wrist or under the left clavicle,

•

the black (-1) lead is connected to the right wrist or under the right clavicle,

•

the green (C or ground) lead is connected to the right leg or on the abdomen.
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Figure HP-7-S1: The IX-EEG recorder with GSR electrodes and three ECG leads connected.
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This lab is meant to be a “hypothesis-driven” lab where students will come up with a technique or
techniques they would like their subject to try in order to alter some aspect of the subject’s
physiological parameters. This can include: reducing heart rate, changing skin conductance, and/or
altering body temperature. The settings file for this lab is currently set up to record: ECG, Skin
Conductance, and Heart Rate. Parameters can be added or removed based on what the goal of the
hypothesis is.

Sample Exercise: Measuring Galvanic Skin Response and Body Temperature Before and After
Imagery

Procedure
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Aim: To measure the subject’s skin conductance and body temperature before and after looking at
“cold” feeling/producing imagery.

1. Select one person from your group to be the subject. Ask the subject to go to the sink, wash his
or her hands with soap and water, and dry them thoroughly. Washing the hands insures that
surface oils or other substances, which might lower skin conduction, are removed. Do not use
alcohol to clean the fingers, alcohol dehydrates the skin.
2. Connect the GSR electrodes as stated in the set up document.

3. Use an oral or surface thermometer to measure body temperature.

4. Attach each GSR electrode to the volar surface of the distal finger segment of two non-adjacent
fingers; the index and the ring fingers are the ones usually used. Attach the electrodes with the
Velcro straps so that the straps are snug, but not overly tight. You may need to slightly moisten
the finger tips for good conduction.
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5. The subject should rest his or her hand with the sensors attached comfortably. The GSR
electrodes should be free from any extraneous pressure and the electrode cable should be
hanging freely. Instruct the subject not to move the hand during the recording process;
movement may introduce artifacts into the recording.
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6. Click on the Record button. Enter the subject's name in the Mark box and press the Enter key on
the keyboard. Since the GSR amplifier is already calibrated, the value displayed on the Skin
Conductance Level channel is the baseline skin conductance level (SCL) of the subject (Figure
HP-7-L1). Record the subject’s baseline SCL for approximately one minute until the recording
stabilizes.
7. Click Stop to halt the recording.
8. Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click
on the Save button to save the data file.
9. Wrap the subject in a warm blanket and let the subject sit and get “warm.” Ask the subject
when he or she begins to feel a bit “sweaty.” Do not allow the subject to get uncomfortable.
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Figure HP-7-L1: Sample data showing skin conductance only. Other channels will show based on the
hypothesis and settings chosen for the lab/research project.
10. Measure the subject’s baseline “warmed” skin or oral temperature.
11. Continue recording.

12. Begin showing your subject images of “cold” feeling/producing images. These images can be
imported and built into the “Sequences” option under Edit => Preferences. Refer to the iWorx
Help manual for more information.
13. Show each image for approximately 5 seconds. Have the subject concentrate on each image,
while thinking “cooling” thoughts and that his or her body temperature is decreasing.
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14. Continue recording and take occasional temperature measurements until you see a noticeable
change in skin conductance and/or body temperature. Record no longer than 30 minutes.
Note: If, at any time, the subject gets uncomfortable being wrapped in the blanket, remove the
blanket and stop the experiment.
15. Click on the Save button to save the data file.
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16. Repeat this exercise on other subjects in your lab group.

Data Analysis

1. Scroll through the data file and locate the recording of the subject’s baseline skin conductance
level (SCL).
2. Use the Display Time icons to adjust the Display Time of the Main window to display the one
minute recording of the subject’s baseline SCL on the Main window. This section of data can
also be selected by:
•

Placing the cursors on either side of the one minute recording of the subject’s SCL, and
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•

Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-7-L2)
to expand or contract the one minute recording to the width of the Main window.
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3. On the right hand margin of the Skin Conductance channel, the mathematical function, Mean,
should appear. The value for mean baseline skin conductance level is displayed here.

Figure HP-7-L2: The LabScribe toolbar.

4. Once the cursors are placed in the correct positions for determining the mean baseline skin
conductance level in the one minute recording, the value for the mean baseline skin
conductance level can be recorded in the on-line notebook of LabScribe by typing the name and
value of the parameter directly into the Journal.
5. Scroll through the data file and locate the recording when the subject was shown images of
“cold” feeling/producing images.
6. Use the Display Time icons to adjust the Display Time of the Main window to display a five
minute section of an area near the end of the imagery recording. This section of data can also be
selected by:

•

Placing the cursors on either side of a five minute section of the end of the recording,
and
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•

Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-7-L2)
to expand or contract the five minute recording to the width of the Main window.

9. Enter the value for the mean “cooled” skin conductance level and body temperature for the
subject in TableHP-7-L1.
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10. If other data, such as Pulse and Heart Rate are being recorded, the data can be selected and
analyzed in the same way.
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Table HP-7-L1: Baseline SCL & Temperature vs. SCL & Temperature after Imagery

Mean “cooled”
SCL (µS)
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Mean Baseline
SCL (µS)

Mean “cooled”
body
temperature
(degrees C)
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Subject’s Name

Mean “warmed”
body
temperature
(degrees C)
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